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SECTION 4  ◊ USING QUERIES 

What will I learn in this section? 

Select Queries 

Creating a Query 

Adding a Table to Query 

Adding Fields to Query 

Single Criteria 

Hiding column in a Query 

Adding Multiple Tables 

Sorting records in a Query 

Query Comparison Operators 

Using And or the Or condition 

Date Criteria 
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Understanding a Select Query 

A Select Query is a way to formulate a question to receive an answer from your database. You first pick the 

table(s) that you would like to see data from and then add the fields from the table to your query grid. The fields 

you pick are the fields for the information you would like to see after the query has been ran. Your database is 

a collection of information and using the criteria row is how you ask a question. By using the criteria row you 

create a dataset or recordset which is a group of records that match your criteria.   

Example: 

 

Notice the WA is on the criteria row in the State column. The question is, “I want all the records that are from 

the state of WA. This is called Query By Example (QBE). 

When you run this query (by clicking on the red exclamation “RUN”  button) you will pull only the records 

that match what you typed. Upper or lower case is not an issue, because Access is looking for the letters and 

ignores the case. 

The query grid has six basic rows that make up the grid.  

Row Name Description 

FIELD Place the field that you would like to add to your query. 

TABLE 
The name of the table the field comes from. When the field is added to 

the gird the table name is added automatically. 

SORT 
Allows you to select what the sort order should be for this column. By 

clicking in the cell a drop down arrow becomes 

SHOW Cancels changes in the current field or current record. 

CRITERIA Switches between editing mode and navigation mode. 

OR Opens a window for editing the contents of long fields. 

 

  

 

The Query Run button. 

 

 

 

Creating a New Query 

By adding the WA in the state column on the criteria row you are creating a Query By Example (QBE). Query 

By Example means that what you type in the criteria row is what Access will look for. When you run your 

query, the results will be displayed in Datasheet View. 
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Open a database and create a query in Design View 

1. Click Search button Win10 or click Start button Win 7. 

  Win10  Win7 

2. Type:   Access 2013 or 2016. 

3. Click  Access 201? on the menu. 

4.  Press Ctrl + F12 to open, verify that  Access Library Class folder is selected. 

5. Double-click  FourthQuery  database file.  

6. Click the  Create  tab above the ribbon. 

 

5. Click the  Query Design  button in the Queries group. 

Your screen should look like this. 
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Adding a table to the query  

1. Double-click the  tblEmployee Personal table in the  Show Table dialog box. 

Your screen should look like this. 

 

2. Click the  Close button on the  Show Table dialog box. 

Adjusting the query window  

1. Maximize  Access window if needed. 

2. Place the mouse on the  horizontal dividing bar and drag down about 1 inch 

down. 

 

  

Tip: You can click on one 

table and then hold down the 

[CTRL] key and click to 

select other tables.  Once you 

have your additional tables 

selected click the ADD button 

so all tables can be added to 

the query. 
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3. Select the  bottom of the table and  drag down until you can see all fields. 

 

Adding fields to your query grid 

1. Double-click the  Last Name field in the tblEmployee Personal table. 
The Last Name field is added to the first column in the grid. 

2. Drag the  First Name field in the tblEmployee Personal table to the second column 

in the grid. 

Your screen should look like this. 

 

3. Release  the mouse button. 

 First Name field is copied to the second column. 

4. Double-click the  Address field in the tblEmployee Personal table. 

5. Double-click the  City field in the tblEmployee Personal table. 

6. Double-click the  State field in the tblEmployee Personal table. 

7. Double-click the  Zip Code field in the tblEmployee Personal table. 

Tip: If you do not have 

enough room to see all fields 

in the table, drag the 

horizontal dividing bar down 

more. The Health Plan field 

is the last field in the table. 

Tip: As you can see you can 

double-click a field to add it 

to the query grid or you can 

drag the field down to the 

grid.  
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Run and save the query 

1. Click the  Run button in the Results group on the Design tab. 

 

Your screen should look like this. 

 

You should have a total of 50 records in your query. 

2. Click the  Save button on the Quick Access toolbar. 

 
The Save As dialog box appears to save the query. 

3. Type:  qryEmployees and click  OK. 
You have saved your new query. 
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Your screen should look like this. 

 You have a new Query. 

 

4. Right -click the qryEmployees title bar and click  Close on the query shortcut 

menu. 

 

You have created a query, but you have not added any criteria to the query grid to select any specific 

records. Currently you query is only pulling the fields from the table that you selected. In the next section 

you will add the criteria that will ask a question of your database using the criteria row structure.  

Selecting Records by Using a Single Criteria 

By adding an item to the criteria row you can select records using the query by example (QBE).   

1. Right-click the  qryEmployeeLocation query and select  the Design View 

from the shortcut menu. 

 

2. Click in the  Criteria row of the Dept column. 

 

3. Type:  SA and press  [ Tab ]. 

  

Tip: You do not need to add 

quotes around the SA, upper 

case or lower case is okay, or 

any item you type on the 

Criteria row. When you press 

the [ ENTER ] or [ TAB ] key 

quotes will be added 

automatically. 
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4. Click the  Run button in the Results group on the Design tab. 

 

 

Your screen should look like this. 

 

You should have a total of 14 records in your query and they are all in the SA department. 

Change the criteria  

1. Switch to  Design View by clicking on the  Design View button. 

 

2. Double-click  SA in the Criteria row. 

3. Type:  MK 

  

Tip: You do not need to add 

the quotes around the SA, or 

any item you type on the 

Criteria row. When you press 

the [ ENTER ] or [ TAB ] key 

quotes will be added 

automatically. 
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4. Click the  Run button on the Design ribbon. 

 

Your screen should look like this. 

 

You should have a total of 5 records in your query and they are all in the MK department. 

Hiding a column in a query  

1. Switch to  Design View by clicking on the  Design View button. 

 

2. Click on the  Check box in the  Dept  field column. 

 
This will remove the check mark and hides the column when the query is run. 
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3. Click the  Run  button on the Design ribbon. 

 

Your screen should look like this. 

 

You should have a total of 5 records in your query and the MK department column is not showing. 

4. Press the  F12  key to open the Save As dialog box. 

You can also click the File tab, point to Save As and click the Save Object As menu. 

5. In the Save As dialog box type:  qryMKdept  

Your screen should look like this. 

 

6. Click the  OK button on the  Save As dialog box. 

7. Close the  qryMKdept query. 

Creating a Select Query using more than one Table 

When you first create a query the Show Table dialog box appears. To add more than one table you select 

more than one using the [CTRL] key or just double-click each table you would like to add.  

The reason you add additional tables to the query pane is, so you can add additional fields from those 

tables. The question is what process is in place to make sure each record from each table is a match? The 

correct record is matched from one table to another because of the relationships between those tables. In 

Access there is a relationship window where you have the ability to setup relationships. You can open 

this window in any Access database to confirm relationships.  
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There are three different types of relationships between tables considered standard.  

Relationship Description 

ONE TO ONE 

A relationship between two tables in which, for each record in one table, there 

is only one record in the second table. The first table to receive data is called 

the Primary table and the second table is called the related table. 

ONE TO MANY 

A relationship in which a record in the primary table can repeat in the related 

table. The primary table has the primary key field and the related table has the 

field known as the Foreign key field.  

MANY TO MANY 

This book will not go into the many-to-many relationship or sometimes call a 

junction table. You can use Help to look up “Relational” to find information 

on this structure. 

 

A relational database is designed to facilitate a relationship structure.   

When you add a second table to your query pane a line automatically connects the two tables. This line is 

called a join line. The join line occurs because data type and field name are the same in the database, but 

in its self is not a relationship. 

If a line is not drawn by Access automatically between two tables, you can connect the two tables as long 

as the field in each of the two tables has the same data type. The field name can be different, but the data 

type must be the same. You cannot just connect any two fields together; they must be the same stored 

data. Example would be the EmpID to EmpID field or Dept to Dept field. 

Adding multiple tables to a query 

1. Click the  Query Design button in the Query group on the Create tab ribbon. 

 
A new query is created and the Show Table dialog box appears. 

2. With  tblDepartments field highlighted, hold down the [ CTRL ] key and click 

on tblEmployee Hire Dates  table. 

3. Click the  Add button on the  Show Table dialog box. 
Your two tables are added to the query pane. 

 

4. Click the  Close button on the  Show Table dialog box. 
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Your screen should look like this. 

 

Notice the join line between the two tables. From the tblDepartment table (the Primary table) there is a 

join line going from the primary key field (Dept) to the Foreign key field (Dept) in the tblEmployee Hire 

Dates table (the Related table).   

5. Double-click the  Dept Name field in the  tblDepartment table. 

6. In the tblEmployee Hire Dates table double-click each field,  Last Name,  

First Name and  Hire Date. 

Your screen should look like this. 

 

7. Click in the  Criteria row of the  Dept Name column. 

8. Type:  Art and press  [ ENTER ]. 

9. Click the  Run button on the Design ribbon. 

 

  

Tip: You do not need to add the 

quotes around the Art, or any 

item you type on the Criteria row. 

When you press the [ ENTER ] 

or [ TAB ] key quotes will be 

added automatically. 
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Your screen should look like this. 

 
You should have a total of 8 records in your query for the Art department. 

10. Press the  F12  key to open the Save As dialog box. 

11. In the Save As dialog box type:  
qryArtdeptHireDates  

Your screen should look like this. 

 

12. Click the  OK button on the  Save As dialog box. 

 

  

Tip: [ F12 ] is the keyboard 

shortcut for Save As. 

You can press [ F12 ] to bring up 

the Save As dialog box to give 

any new object a name. 
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Add a third table to a query 

1. Switch to  Design View by clicking on the  Design View button. 

 

2. Click the  Show Table button on the Design ribbon. 

 

3. Double-click the  tblEmployee Personal table. 

4. Click the  Close button on the  Show Table dialog box. 

5. From the  tblEmployee Hire Dates table, drag  Emp ID field to the 

tblEmployee Personal table, on to the  EmpID field. 

Your screen should look like this. 

 

6. Release  the mouse button. 
You now have a join line. 

Your screen should look like this. 
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Adding fields from the third table to the query 

1. In the  tblEmployee Personal table, double-click the  Salary field. 

You may need to scroll down to see the Salary field. 

 

2. Click the  Run  button on the Design ribbon. 

 

Your screen should look like this. 

 

3. Click the  Save  button to save the query. 
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Sorting records in a query 

1. Switch to  Design View  by clicking on the Design View button. 

 

2. Click in the  Sort row of the  Last Name column. 

Your screen should look like this. 

 

3. Click the  down arrow on the sort row, on the right side of the  Last Name column. 

Your screen should look like this. 

 

4. Click on  Ascending to sort the  Last Name column in Ascending order. 

5. Press the  [ TAB ] key. 

6. Click the down arrow on the sort row, on the right side of the  First Name 

column. 

7. Click on  Ascending to sort the  First Name column in Ascending order. 

Your screen should look like this. 
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8. Click the  Run button on the Design ribbon. 

 

Your screen should look like this. 

 
Notice the Corwick’s first names, you should have 7 records. 

9. Click the  Save  button on the Quick Access Toolbar. 

 

Query criteria with comparison operators 

Comparison operators help you select records that meet a predefined value. The table below lists the 

operators and their description. 

Comparison 
Operators 

Description 

< 
Less than: Gives you all numbers less than the number you type in the criteria cell. Example:  

< 25   You will get all numbers that are less than 25. 

> 
Greater than: Gives you all numbers greater than the number you type in the criteria cell. 

Example:  > 25 

You will get all numbers that are greater than 25. 

= 
Equal to: If you type a number, Access will match the number you typed in the criteria cell. 

Example:   = 14 

You will get all numbers that are 14. 

<= 
Less than or equal to: Gives you all numbers less than the number you type and the number 

you type in the criteria cell. Example:  <= 25 

 

>= 
Greater than or equal to: Gives you all numbers greater than the number you type and the 

number you type in the criteria cell. Example:  >= 25 

<> Not equal to: Gives you all the records but the one you type. 

ALL THE ABOVE 
All of the operators can be used with the alphabet. Think of the A as being a 1, and the Z as 

being 26. Example:  > M 

You get all the records from M - Z. Yes, it includes the M. 
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Using operators in a query 

1. Verify that  qryArtDeptHireDates query is in  Design View. 

2. Delete  the text  “Art”  in the  Criteria row in the first column. 
Hint: Select the text with the mouse and press the Delete key. 

3. Press  F12  to open the Save As… dialog box. 

4. In the Save As dialog box type:  qrySalaries  

Your screen should look like this. 

 

5. Click the  OK button on the  Save As dialog box. 

6. In the Criteria row under the  Salary column type:   >30000 
This will give you all records greater than 30,000. 

7. Press  [ TAB ] and click the  Run button on the Design ribbon. 

 

  

Tip: [ F12 ] is the keyboard 

shortcut for Save As. 

You can press [ F12 ] to bring 

up the Save As dialog box to 

give any new object a name. 
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Your screen should look like this. 

 
You have 23 records for individuals who make more than $30,000. 

Changing criteria in a query 

1. Switch to  Design View by clicking on the  Design View button. 

 

2. In the Criteria row under the  Salary column delete the  >  symbol. 

3. Replace it by adding the  <  symbol in front of the 30000. 
This will give you all records less than 30,000. 

4. Press the  [ TAB ] key.  

Your screen should look like this. 
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5. Click the  Run  button on the Design ribbon. 

 

Your screen should look like this. 

 
You have 19 records for individuals who make less than $30,000. 

Using AND or the OR condition 

You can create complex queries by using the AND condition with your criteria row. The AND condition 

normally will give you less records. Where the OR condition normally give you more records. 

With the AND condition criteria you are asking for two items from a single record that match. When these 

items match you will get the record.  

With the OR condition criteria, you will take one record based on a single criteria and a different record 

based on the second criteria. These two records do not need to match each other as they do in the AND 

condition.   

Operators 
Fields  

in Query 

Example of  
Criteria placed 

in the field column 
Description 

AND 
Dept Name 

 

Salary 

Art 

 

<30000 

By placing the word Art on the criteria row 

(in the Dept Name column) along with 

<30000 on the criteria row (in the Salary 

column) this creates an AND condition. 

Question: I want to know all the employees 

in the Art dept who make less than $30,000. 

OR Dept Name Art  OR  Accounting 

By placing the word Art and Accounting in 

the same column on the criteria row, we can 

pull all the Art records and all of the 

Accounting records.  

Question: I want all the employees from 

both departments, Art and Accounting. 

AND 

with 

OR 

Dept Name 

Salary 

Dept Name 

Art 

<30000 

Accounting 

This is just like the first example however; 

the Accounting text is placed on the OR row 

in the Dept Name column.  

Question: I want all the employees from the 

Art department who make less than 30,000 

and plus all the employees from the 

Accounting department. 

NOTE: 
Looking at the query grid you will notice that you have a Criteria row and you have an OR row. If 

more than one criteria is placed in a different column on the same row you are creating an AND 
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condition. If you place your second criteria or other criteria on the OR row you will create an OR 

condition.  

 

Creating an AND condition 

1. Switch to  Design View by clicking on the  Design View button. 

 

2. Type:  Art  in the Criteria row in the Dept Name column and press  [ TAB ]. 

Your screen should look like this. 

 

3. Click  Run  button on the Design ribbon. 
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Your screen should look like this. 

 

You have 3 records for individuals from the Art department who make less than $30,000. 

Creating an OR condition 

1. Switch to  Design View  by clicking on the  Design View button. 

 

2. Delete the  <30000  from the Criteria row in the Salary column. 

3. On the  OR  row in the Dept Name column type:  Accounting 

4. Press the  [ TAB ] key. 

Your screen should look like this. 

 

5. Click the  Run button on the Design ribbon. 
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Your screen should look like this. 

 
You have 13 records for individuals from both Art and Accounting departments. 

Mixing AND and the OR condition 

1. Switch to  Design View  by clicking on the  Design View button. 

 

2. Delete  the word  “Accounting”  from the  OR row. 

3. Click to the right of the word  Art and press the  [ SPACEBAR ] key.  

4. Type:  Or  and press the  [ SPACEBAR ] key. 

5. Type:  Accounting  and press the  [ TAB ] key. 

Your screen should look like this. 

 

6. Press the  [ TAB ]  key three times. 

7. On the  Criteria  row in the  Salary column type:  >30000 
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Your screen should look like this. 

 

8. Click the  Run  button on the Design ribbon. 

 

Your screen should look like this. 

 

You have 7 records for individuals from both Art and Accounting departments who make more than 

$30.000. 

9. Click  F12 and the Save As dialog box appears. 

10. In the Save As dialog box type:  
qryArt&AccountingSalariesover30  

Your screen should look like this. 

 

11. Click the  OK button on the  Save As dialog box. 

12. Close the  qryArt&AccountingSalariesover30  query. 

Tip: [ F12 ] is the keyboard 

shortcut for Save As. 

You can press [ F12 ] to bring 

up the Save As dialog box to 

give any new object a name. 



  Access 2013/2016 Queries 

  25 

Working with Date criterion 

1. Right-click the  qryHire Dates query and select  Design View. 

 

2. In the Criteria row under the  Hire Date column, type:  > 12/31/1999 

3. Press the  [ TAB ] key once. 

Your screen should look like this. 

 

4. Click the  Run  button on the Design ribbon. 

 

Your screen should look like this. 

 

You have 16 records for individuals who started with the company after 12/31/1999. 
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5. Switch to  Design View  by clicking on the  Design View button. 

 

6. Delete  the contents of the Criteria row in the Hire Date column. 
Hint: Select the text with the mouse and press the Delete key. 

7. In the Criteria row under the  Hire Date  column, type:  <= 12/31/1999 

8. Press the  [ TAB ] key once. 

Your screen should look like this. 

 

9. Click the  Run  button on the Design ribbon. 

 

Your screen should look like this. 

 

You have 33 records for individuals who started with the company on or before 12/31/1999. 
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Working Between Dates  

1. Switch to  Design View  by clicking on the  Design View  button. 

 

2. Delete  the contents of the Criteria row in the Hire Date column. 
Hint: Select the text with the mouse and press the Delete key. 

3. In the Criteria row under the  Hire Date  column. 

4. Type:  Between 1/1/1995 And 12/31/1999 

5. Press the  [ TAB ] key once. 

Your screen should look like this. 

 

6. Click the  Run  button on the Design ribbon. 

 

Your screen should look like this. 

 

You have 22 records for individuals who where hired between 1/1/1995 to 12/31/1999. 

Tip: You can see your date 

expression in the criteria row if 

you place the mouse pointer on 

the dividing line between the 

two columns press and drag to 

the right. 

 
You can also press the  

[ SHIFT + F2 ] key combination 

to open the Zoom window to 

also see the expression. 
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7. Click  F12 and the Save As dialog box appears. 

8. In the Save As dialog box type:  qryHires95to99  

Your screen should look like this. 

 

10. Click the  OK button on the  Save As dialog box. 

11. Close the  qryHires95to99  query. 

Close the database and exit Access 

1.  Click on the  File tab and click Close from the Backstage menu.  
The database closes. 

2. Click on the  X in the top right corner to Exit Access. 
MS Access closes. 

Tip: [ F12 ] is the keyboard 

shortcut for Save As. 

You can press [ F12 ] to bring 

up the Save As dialog box to 

give any new object a name. 

Tip: You can use the 

keyboard key combination of 

[CTRL + F4] to quickly 

close your database. 

You can use the  

[ALT  +  F4] to quickly close 

Access. 
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Section 4 – Exercise   

Scenario 

You need to pull records by using queries. 

What to Do: Build queries to pull the records you need by using criteria. 

A place to start 

1. Use the  Start button on the taskbar to open  Microsoft Access.  

For an example, refer to page Error! Bookmark not defined.. 

2. Click the  Open button, verify that  Classwork folder is selected. 

3. Double-click  FourthQuery_Exercise database file.  

4. Open the  qryEmployee Addresses  query. How many records to you have? 

For an example, refer to page Error! Bookmark not defined.. 

5. Create a new query based on the   tblEmployee Personal  table. Add the Last 

Name, First Name, Address, City, State and Zip Code fields to your grid. 

For an example, refer to page 5. 

6. Run the query to see all the records. 

7. Add a criteria of “OR” to the state column. 

For an example, refer to page 7. 

8. Save your query as qryOR_State. 

For an example, refer to page 18. 

9.  In design view sort the City column in Ascending order and save the query. 

For an example, refer to page 16. 

10. Click on the  File tab and click Close from the Backstage menu.  
The database closes.  

11. Click on the  X in the top right corner to Exit Access. 

MS Access closes. 

 



  Access 2013/2016 Queries 

  30 

Section 4 – Review 

You must be able to answer the following questions on your own. As you review the questions below, 

write in your answer below each one.  

 

1. How do you create a query? 

2. How do you add fields to the query grid? 

3. How do you sort a column in a query grid? 

4. Access uses Query By Example in the query grid, what does this mean? 

5. What happens when you remove the check mark in a column on the Show row? 

6. What does One-to-One mean when describing the relationship between two tables? 

7. What is the Save As keyboard shortcut key? 

 

Additional Study  

Use the Microsoft Access help features to look up the key words from this section for 

additional information. Example: Query, Select Query, and Criteria 

 

My Notes: 

  

 


